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From the Chair

Greetings Section Members

 I hope this letter finds you all happy and healthy and ready for warmer weather!

There are many exciting things to share with you. First, the Council has two new
 members. Please join me in welcoming Denise Glassmeyer and Sally VanDenBerg
 (Sally actually rejoins us, having been a member in the past).

 Rebecca Simkins is still keeping busy with the Law School Outreach Program. We now
 have had every law school in the state express an interest in our program. Rebecca is
 working on coordinating speaking engagements for our members with the various law
 schools. Thanks, again, Rebecca!

 We sent two of our members to the TechShow in Chicago. They both found it to be
 extremely informative, as always. Look for their articles in our newsletter!

 Don't forget to check out our Facebook page! While you're there, check the box that
 indicates that you "like" us. It will increase our exposure to other interested parties.

 At our last meeting, the Council voted to provide some financial support in the way of a
 $1,500 contribution to the Sophomore Summer Institute. This is a very worthwhile
 cause, as it provides extra help for students who are interested in a legal career in the
 future. Many of these students are disadvantaged and would not be able to attend
 without financial support. Additionally, we have been invited to participate in the
 program, which takes place in June. Three or four of our members will join in a panel
 discussion with the students.

Our officers participated in the Bar Leadership Forum at Mackinac Island on June 10-11.
 This event included a day-long meeting of the Strategic Planning Committee, where
 participants planned for the future of our Section.

Remember, the Council still has vacancies that need to be filled. If you know someone
 who might be interested in serving, please pass his or her name on to an officer. The
 time commitment is manageable, and it's a great opportunity to serve our Section.

Our next meeting will be held in Novi, at the Crowne Center Hotel, on July 16. Until then,
 have a safe and happy summer!

 Stacey L. Dinser-Hohl has a practice in Hamburg and is the Section chair.

We are Now on Facebook
By Melonie Stothers

The Law Practice Management & Legal Administrator's Section of the State Bar of
 Michigan is now on Facebook. Join us by clicking the link below and liking us.

http://www.facebook.com/LPMandLASection

 Content from the Section will be sent directly to your feed. You'll receive updates on
 meetings, notices of events, and links to articles to help you better your practice. Using
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 the discussion functions and wall, all members can raise questions on the page, take
 part in discussions, and learn from other Michigan lawyers the tools that work best and
 worst for their practice. Take part in the conversation and like us today!

 Don't know how to "like" a page on Facebook? First, you must be a member of
 Facebook. After you log into Facebook, click the link above. You should then see a page
 that looks similar to the attached picture. The picture identifies where the "like" button
 can be found for the LPM&LA Section.

Are you having problems seeing the LPM&LA updates despite having liked the page?
 Check your feed settings. The default setting for Facebook only shows you the pages
 you regularly interact with in your home feed. To ensure you are seeing all of the posts
 from the LPM&LA Section, slowly scroll to the bottom of your Facebook home page.
 You'll see a box that looks like the blue one below. Click "Edit Options" and choose to
 show posts "from all friends and pages."

 Melonie is a commercial litigator with Barris, Sott, Denn & Driker, PLLC in
 Detroit. She focuses her practice in electronic discovery and evidence.

 

 

2011 ABA TechShow
By Kris Krol

2011 was the 25th anniversary of the ABA TechShow in Chicago. I was lucky enough to
 be able to go this year for the first time ever. For me, a self-proclaimed technogeek with
 six desktop computers sitting in my home office, a MacBook, and several different
 formulations of iPods, two iPhones, and two iPads, it was really cool! I was in technology
 heaven. This event is something every person who deals with law office technology
 should attend at least once.

There were many offerings for educational sessions. I sat through all the iPhone/iPad
 trainings I could manage to find. There was even a "Taste of TechShow" dinner devoted
 to discussion of iPhone/iPad on Monday night at Tutto Italiano (very good food). Some
 of the educational sessions I attended were, "60 iPhone/iPad Apps in 60 minutes,"
 "Meet the Author— iPad in One Hour for Lawyers" with Tom Mighell, "60 Apps in 60
 Minutes," and "60 Sites in 60 Minutes." The talk with Tom Mighell was educational, even
 though I don't consider myself new at the iPad, and his book is quite basic. I highly
 recommend it for the new iPad owner/user, because he includes a chapter on apps that
 allow a lawyer to be productive with the iPad. Although iPad may have originally hit the



 market as a cool "large iPod Touch," a lawyer can be very productive with it. I've
 stopped taking my MacBook to court, in favor of my iPad and Apple wireless keyboard.
 Tom's book also has other valuable "getting started" information, which I found to be
 valuable to the new user.

Aside from good content, TechShow also offers some fun events. One of these was
 Monday evening's presentation of 25 years of technology—very interesting. I purchased
 my first computer and laser printer for business use in 1989, for $1,500 each. I still have
 the HP LaserJet Series II printer in my home office however, I don't use it, having
 upgraded to an HP Color LaserJet 2025dn, which is pretty sweet. Interestingly, at the
 age of 44, I actually recognized most of the items in the presentation. The presentation
 was part of a reception/cocktail-hour atmosphere, though so it was really there for those
 who were interested in paying attention to it. This was nicely done.

This article would not be complete without my review of the accommodations. The
 TechShow was held at the Hilton-Chicago on South Michigan Avenue, overlooking
 Grant Park. It's a lovely hotel, and I enjoyed my stay there. The room had a different
 layout from the standard hotel room, kind of a u-shape. The staff was helpful and did a
 nice job of taking care of us. I was disappointed in a couple of things, however.

When I travel, I must have Internet. While the price for the room is not outrageous, wi-fi
 in the rooms should be an included amenity. They do have a media system in the room,
 the use of which you may charge to your room. It allows you to get online for a premium,
 or you can do social media or other limited-use features. You can even get Internet radio
 for soothing sounds in the room, also for a fee. The other problem was the wi-fi available
 for the conference itself. I discovered that limited or non-existent wi-fi service for the
 conference has been an ongoing problem with the Hilton for the few years the
 TechShow has been there. This year they had assured TechShow staff that there would
 be good Internet access.

Overall, I enjoyed myself, met some great people and learned a lot. This is certainly
 worth the trip if you love law office technology or you just have a love-hate relationship
 with your technology. You can't go to TechShow and not come back with some golden
 nuggets that will be useful for your office.

Kristen Krol is small-firm attorney with Debt Relief Legal Clinic of Michigan,
 in Lansing, specializing in Chapters 7 and 13 Bankruptcies. Until December
 2010, she was a solo attorney in her own practice, the Krol Law Firm, also
 of Lansing, for 12 years. Ms. Krol is keen on technology and how it can be
 used best in the efficient practice of law and is available to assist other

 lawyers in assessing their own needs in the area of technology. She can be reached at
 (517) 321-6804 or kris@drlc.com.

Breaking the PowerPoint Mold
By Melonie L. M. Stothers

Normally, PowerPoint presentations are predictable, common place, and boring. That
 doesn't have to be the case though. PowerPoint can be a very powerful tool if used
 properly and with thought: it can animate models, integrate text with video, audio, and
 other visual aids, and it can be used to highlight evidence in a way that captures the
 attention of jurors, judges, and mediators who are regularly inundated with flashy
 courtroom dramas from television and movies.

 To fully harness the power of PowerPoint, the first thing you need to do is throw away
 what you know about PowerPoint presentations. Your presentation should not be
 geared around an outline of text, but instead should be developed from the evidence
 you are presenting.

 Start simply by loading each piece of evidence on one slide. This should include
 photographs of the accident scene, the victim, and the witnesses, images of key
 documents, clips from video depositions, and any audio, such as a 911 call. Do not
 worry about the order of the slides or how it all fits together. Merely gather all of the
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 multi-media evidence in your presentation. (To insert pictures or video, click "Insert,"
 then "Picture" or "Video.")

 After the evidence is gathered, begin developing your story by moving slides and adding
 focal points. Text should be used sparingly and with purpose (not simply as notes from
 which you read). Refrain from using the busy templates offered as part of the program.
 Start with a plain background with contrasting, easy to read text (i.e., white on black).
 Take time to think through your argument and continuously revise, allowing your
 presentation to evolve over time. (Only at the very end should you add final color and
 style, taking into consideration your audience and subliminal messages that may be
 conveyed through color.)

 Once the basic evidence is in place, identify the portions to highlight, such as the key
 phrase in a contract or a particular point on a picture. This is where PowerPoint shines.
 You can easily create custom animations to make callouts and draw the viewer's
 attention to the screen.

 The easiest way to create a callout from a contract is to paste a second copy of the
 contract in the slide with the original image. Click on the picture to open the "picture"
 toolbar, then "crop" the contract portions down to the language you want to highlight and
 drag the corner to increase the size of the callout. Click the cropped language, then
 choose the "Animations" tab. Choose "Add Animation." For callout purposes, a subtle
 "Entrance" effect is probably best, such as "Expand." (If you do not see "Expand" in the
 main list of entrance effects, choose the option for "More Entrance Effects.")

 To add a border to your callout, simply right click the cropped contract language, choose
 "Format Picture," then "Line Color," "Solid line," and choose a line color. Double click the
 image to the left to open a sample presentation, hit the F5 key on your keyboard, and
 click again to see the callout.

You can create an animated model for your presentation using the same technique.
 Starting with a blank slide, open the "Insert" toolbar, add a "Shape" such as a rectangle
 to represent a car, "Clipart," or a "Picture." Open the "Animations" tab. Click on your
 shape, choose "Add Animation," then "More Motion Paths." From there, you can choose
 how you want to make your car move. If you break down the movements at each turn,
 by adding spin animation, you can make the car look real. For example, choose "More
 Motion Paths" and "Right." Then add the animation "Spin" (under the heading
 "Emphasis") and, under "Effect Options," set the spin to 90o counterclockwise. Then
 add another animation of "More Motion Paths" and "Up." You should get your rectangle

 to t urn left. (If the animation doesn't follow the correct path,
 click on the second animation line and move it to the end of the first animation line.) To
 make it so that your car moves without mouse clicks between each animation, open the
 "Animation Pane" click on each animation in the list, then click the down arrow and
 choose "Start After Previous." To open the sample presentation to the left, double click
 on the image, hit the F5 key on your keyboard, then click to see the rectangle.

By adding further animation and more drawings, and placing the animation over the
 picture of a street scene, you can easily see how PowerPoint enables an attorney to
 make dynamic presentations.
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 These same techniques can be also used to make a timeline come to life. Starting with a
 blank screen, from the "Insert" toolbar, choose "Table," then "Insert Table," and choose
 1 row and 12 columns. Format your timeline using the tools at the top (the paint bucket
 will change the background color of the timeline and the icon that looks like four squares
 will add borders). Simply type in the boxes to add the text of each month (formatting the
 text is done using the "Home" tab).

 To add timeline callouts, simply draw the callouts using the "Insert" toolbar, choosing
 "Shapes," then "Callouts." To change the color from the
 callout, right click it, choose "Format Shape." To add text,
 simply insert a text box. You should now have a simple
 timeline like this:

To animate this timeline, first group each text box with its
 callout by holding the "Ctrl" key and click the two to group.
 Then right click and choose "Group", then "Group". Using
 the "Animation" tab, you can make each grouped box show up in the proper time order
 just by custom animating each box in order with the entrance "Expand." Double click the
 image above to open the sample presentation, hit the F5 key on your keyboard, and
 then click again to see the simple animation. Continue clicking to watch each event
 appear. By making the animation occur on a mouse click, the presenter controls when
 the audience learns the particular point.

Practicing with those simple techniques will take your presentations to a new level,
 adding depth and interest.

 Melonie is a commercial litigator with Barris, Sott, Denn & Driker, PLLC in
 Detroit. She focuses her practice in electronic discovery and evidence.

 

Coach's Playbook
By Elizabeth Jolliffe

Positioning For Your Future
 Several of my clients want to work as in-house counsel some day. A few others would
 like to be a judge. Most of my clients want to stay where they are and continue
 expanding their practice. Regardless of their personal goals, they are all thinking about
 how to best position themselves for a good future.

No matter your end goal, here are a few basic keys to your future.

1. Start now. It is never too soon or too late to position yourself for a better future. If
 you don't have many contacts in your desired field, figure out a way to make
 them and get started. If you notice that most corporate positions require
 experience you lack, find a way to fill that gap or demonstrate the same skills in
 a different setting. If you want to be a judge, start developing name recognition
 with either the people who could elect you or those who could appoint you.

2. Build on your strengths. Assess your professional and personal strengths and
 capitalize on them. Rather than spending most of your time trying to fix your
 weaknesses, spend more time developing your natural strengths. For more on
 this approach, check out various books on strengths identification and
 development by Marcus Buckingham, Donald Clifton, and Tom Rath.

3. Be the professional you would want to hire. A potential interview question is:
 "How would your co-workers describe you?" Regardless of your future goals,
 make sure you really are living up to how you would want your clients or co-
workers to describe you. Acknowledge this and start aligning your behaviors with
 your values. If you are behind on entering your time, you keep breaking
 promises to clients, or you have trouble staying focused on projects until
 completion, chances are you aren't being the lawyer you would want to hire.

You can wait for your future to happen to you or you can control what you can and start
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 positioning yourself. String together a series of small steps to make these changes and
 then keep going. It's your future.

Elizabeth Jolliffe is a certified career management and business development
 coach for lawyers. She practiced for 19 years as a business litigator and
 partner at Clark Hill PLC. Elizabeth helps her clients take charge of their
 career and reach their own definition of success. (734) 663-7905 or
 Elizabeth@YourBenchmarkCoach.com.

Help Me With Hiring!!
By Rebecca Simkins

Believe it or not, even in this economy, attorneys and businesses continue to hire
 employees. Even with a large number of available applicants, it is still a challenge to find
 the right person to work at your law practice. I have been asked by a number of lawyers
 at different size firms about hiring, so I thought I would offer a few tips to help find the
 best candidate. While the emphasis is on support staff hiring, these strategies should be
 implemented for any hiring need.

One of the most important assets to the success of your business is its people. Your
 legal education is at the top of the list, but a good staff is a close second. For the law
 office, support staff and associate lawyers are often the eyes, ears, and voice of the
 lawyer. Associates have a behind the scenes role, or one that involves extensive contact
 with potential and existing clients. Therefore, it is critical that lawyers invest the time,
 energy and effort to identify the best candidate and to make sure that the person has the
 necessary skill set to succeed. To do this, lawyers must make the time for an effective
 interview, obtain a signed employment application, test skill set, and set a probationary
 period after hire.

A. The Employment Application.

A candidate may be seeking employment at a law firm in response to an ad, word of
 mouth, or just on a cold call basis. Every person that you intend to interview must fill out
 an application for employment. If you don't use one, start now. The application will allow
 you to obtain the potential employee's consent to certain terms and conditions, before
 you even begin to interview. If a person refuses to sign an employment application and
 agree to the terms and conditions set forth, there is no reason to continue the interview
 and the applicant should be provided with brief information about the law firm (always
 think about marketing) and thanked for their time.

The employment application should include legal requests for information about job
 experience and education. It should also seek agreements to certain terms and
 conditions of employment, which should include an affirmation of at-will employment, an
 affirmation that the information provided by the applicant is true and an understanding of
 the consequences if it is not, an express authorization to check references and
 communicate with prior employers, and an agreement to abide by company rules. The
 application should also advise that if there is a need for accommodation due to a
 disability that it must be disclosed as soon as possible, but no later than 182 days after
 the need for accommodation arose.

Once you have the executed employment application, what can you learn from it?

Penmanship, grammar, and spelling. Is this a person who will be hand-writing
 messages to you? Does the application appear to be neat and complete?
Job history—Is the person a job hopper? Are there blocks of time between
 positions?

If the interview goes well, check references and verify information provided in the
 application, including employment history and education. This is a critical, but often
 overlooked step.

B. From Application to Interview.
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Once you have the signed employment application, you must conduct a meaningful
 interview. This requires preparation on the part of the interviewer. What is the position
 and job description for the job you would like to fill? If you don't have a job description—
jot down the job duties for the job. What are the traits/skills of your ideal candidate? What
 special skills do you need? What are you willing (and able) to pay someone? What
 benefits can you provide? Are you realistic in terms of what you can pay and what you
 are looking for? Can you offer flexibility to an employee? Have all of this information
 thought out and prepared in advance.

The interview is the one chance an employer has to spend time with a person before
 they are hired. Unfortunately, lawyers do more talking than listening. (Are you
 surprised?) While I encourage every lawyer to market their practice a little during an
 interview—the purpose of the interview is to get to know the candidate. Questions to the
 applicant should be job related, and be framed as broad questions to get the applicant
 talking. Some of us spend more time with our co-workers than our family, so this is a
 critical step.

I personally think the best interview can only occur if the interviewee takes the time to
 make the applicant feel comfortable. This is a nervous time and we want to see the best
 in the person who has come to our business for a job. I always engage in a little small
 talk to make the person feel comfortable. I provide a brief history and overview of the
 firm. Then I go through the application, and discuss the employment and educational
 history. In terms of getting to know the candidate, avoid questions that state things like,
 "This is a stressful place—can you handle stress?" Instead focus on open-ended
 questions such as:

What do you like (or don't like) about working at a law firm?
What are the biggest challenges you face working at a law firm?
What is the most difficult situation that you have encountered, with a client or co-
worker? How did you resolve it?
What areas of the law have you worked in? Which did you like the most? Why?

Or ask for a descriptive answer by asking questions such as:

How would you describe your style as a
 secretary/attorney/bookkeeper/receptionist in 3 words?
What are the three most important things that you look for in a job?

Remember when you are interviewing—do more listening than talking.

C. Legitimate Non-Discriminatory Reason for Hire/Not Hire.

Once you meet the applicant for the interview, you may know fairly quickly if the
 applicant is definitely not going to be a fit. When this happens, write the legitimate non-
discriminatory reason on the application. The application is to be kept for three years,
 pursuant to the Elliot Larson Civil Rights Act since even workers who were not hired can
 file a civil rights charge claiming that they were not hired due to a discriminatory reason.

I recall interviewing an applicant for a receptionist person at a law firm. I knew within a
 few minutes that this person was not a fit for the job. She appeared at the interview in
 heavy make-up and dressed very unprofessionally. She chewed gum during the
 interview and responded to some questions, "yeah." These facts were noted on the
 application and then it was filed away so that I would recall the legitimate non-
discriminatory reasons for not hiring this candidate for a receptionist position.

A client of mine interviewed a disabled person for an accounting position. All of this
 accounting firm's employees are tested for certain basic accounting skills. This applicant
 did very poorly on all the testing. The employer maintained all test results and when the
 applicant filed a civil rights charge claiming she was not hired due to her disability, the
 employer was able to produce the test results, showing a legitimate non-discriminatory
 reason for not hiring her.

D. Testing Skills.



Simply put—test skills. You must verify that the person that you are hiring can type as
 fast as they say they can, and put together a pleading, proofread a document, draft a
 letter, whatever skill you need, etc. How do you find out about this? By completing
 thorough testing and reference checking. Maintain test results and reference information
 with the application.

E. 90-Day Probation.

This is a reasonable part of the hiring process. If you want an employee to succeed,
 "maximum 90-day probation" can help you do this. Every 30 days, or even more
 frequently, if possible, the employer and the new employee can talk about performance
 issues that need to be corrected, training issues, and how things are going. Probationary
 periods should include an understanding that termination can take place any time during
 the probationary period.

Final thought: If you have any questions regarding these suggestions, you should
 discuss them with a lawyer knowledgeable about employment law.

Nothing in this article is to be construed as legal advice.

Rebecca Simkins is a member of Barris, Sott, Denn & Driker, P.L.L.C. where
 she practices labor and employment law, representing management. She is a
 past chair of the Law Practice Management Section. She also taught law
 practice management and Detroit College of Law/Michigan State College of
 Law and Cooley Law School. If you have questions regarding this article or

 the topics discussed, please contact Ms. Simkins. She can be reached at (313) 596-
9319, e-mail: rsimkins@bsdd.com, at 211 West Fort Street, 15th floor, Detroit, MI 48226.

;
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